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			1. Introduction

			This book, fully updated for Android Studio Jellyfish (2023.3.1) and the new UI, teaches you how to develop Android-based applications using the Kotlin programming language.

			This book begins with the basics and outlines how to set up an Android development and testing environment, followed by an introduction to programming in Kotlin, including data types, control flow, functions, lambdas, and object-oriented programming. Asynchronous programming using Kotlin coroutines and flow is also covered in detail.

			Chapters also cover the Android Architecture Components, including view models, lifecycle management, Room database access, content providers, the Database Inspector, app navigation, live data, and data binding.

			More advanced topics such as intents are also covered, as are touch screen handling, gesture recognition, and the recording and playback of audio. This book edition also covers printing, transitions, and foldable device support.

			The concepts of material design are also covered in detail, including the use of floating action buttons, Snackbars, tabbed interfaces, card views, navigation drawers, and collapsing toolbars.

			Other key features of Android Studio and Android are also covered in detail, including the Layout Editor, the ConstraintLayout and ConstraintSet classes, MotionLayout Editor, view binding, constraint chains, barriers, and direct reply notifications. 

			Chapters also cover advanced features of Android Studio, such as App Links, Gradle build configuration, in-app billing, and submitting apps to the Google Play Developer Console.

			Assuming you already have some programming experience, are ready to download Android Studio and the Android SDK, have access to a Windows, Mac, or Linux system, and have ideas for some apps to develop, you are ready to get started. 

			1.1 Downloading the Code Samples

			The source code and Android Studio project files for the examples contained in this book are available for download at:

			https://www.payloadbooks.com/product/jellyfishkotlin/

			The steps to load a project from the code samples into Android Studio are as follows:

			1. From the Welcome to Android Studio dialog, click on the Open button option.

			2. In the project selection dialog, navigate to and select the folder containing the project to be imported and click on OK.

			1.2 Feedback

			We want you to be satisfied with your purchase of this book. If you find any errors in the book, or have any comments, questions or concerns please contact us at info@payloadbooks.com.

			1.3 Errata

			While we make every effort to ensure the accuracy of the content of this book, it is inevitable that a book covering a subject area of this size and complexity may include some errors and oversights. Any known issues with the book will be outlined, together with solutions, at the following URL:

			https://www.payloadbooks.com/jellyfishkotlin

			If you find an error not listed in the errata, please let us know by emailing our technical support team at info@payloadbooks.com. They are there to help you and will work to resolve any problems you may encounter.

		

	
		
			2. Setting up an Android Studio Development Environment

			Before any work can begin on developing an Android application, the first step is to configure a computer system to act as the development platform. This involves several steps consisting of installing the Android Studio Integrated Development Environment (IDE), including the Android Software Development Kit (SDK), the Kotlin plug-in and the OpenJDK Java development environment. 

			This chapter will cover the steps necessary to install the requisite components for Android application development on Windows, macOS, and Linux-based systems.

			2.1 System requirements

			Android application development may be performed on any of the following system types:

			•Windows 8/10/11 64-bit

			•macOS 10.14 or later running on Intel or Apple silicon

			•Chrome OS device with Intel i5 or higher

			•Linux systems with version 2.31 or later of the GNU C Library (glibc)

			•Minimum of 8GB of RAM

			•Approximately 8GB of available disk space

			•1280 x 800 minimum screen resolution

			2.2 Downloading the Android Studio package

			Most of the work involved in developing applications for Android will be performed using the Android Studio environment. The content and examples in this book were created based on Android Studio Jellyfish 2023.3.1 using the Android API 34 SDK (UpsideDownCake), which, at the time of writing, are the latest stable releases. 

			Android Studio is, however, subject to frequent updates, so a newer version may have been released since this book was published.

			The latest release of Android Studio may be downloaded from the primary download page, which can be found at the following URL:

			https://developer.android.com/studio/index.html

			If this page provides instructions for downloading a newer version of Android Studio, there may be differences between this book and the software. A web search for “Android Studio Jellyfish” should provide the option to download the older version if these differences become a problem. Alternatively, visit the following web page to find Android Studio Jellyfish 2023.3.1 in the archives:

			https://developer.android.com/studio/archive

			2.3 Installing Android Studio

			Once downloaded, the exact steps to install Android Studio differ depending on the operating system on which the installation is performed.

			2.3.1 Installation on Windows

			Locate the downloaded Android Studio installation executable file (named android-studio-<version>-windows.exe) in a Windows Explorer window and double-click on it to start the installation process, clicking the Yes button in the User Account Control dialog if it appears. 

			Once the Android Studio setup wizard appears, work through the various screens to configure the installation to meet your requirements in terms of the file system location into which Android Studio should be installed. When prompted to select the components to install, ensure that the Android Studio and Android Virtual Device options are both selected. 

			Although there are no strict rules on where Android Studio should be installed on the system, the remainder of this book will assume that the installation was performed into C:\Program Files\Android\Android Studio and that the Android SDK packages have been installed into the user’s AppData\Local\Android\sdk sub-folder. Once the options have been configured, click the Install button to complete the installation process. 

			2.3.2 Installation on macOS

			Android Studio for macOS is downloaded as a disk image (.dmg) file. Once the android-studio-<version>-mac.dmg file has been downloaded, locate it in a Finder window and double-click on it to open it, as shown in Figure 2-1:

			[image: ]

			Figure 2-1

			To install the package, drag the Android Studio icon and drop it onto the Applications folder. The Android Studio package will then be installed into the Applications folder of the system, a process that will typically take a few seconds to complete.

			To launch Android Studio, locate the executable in the Applications folder using a Finder window and double-click on it.

			For future, easier access to the tool, drag the Android Studio icon from the Finder window and drop it onto the dock.

			2.3.3 Installation on Linux

			Having downloaded the Linux Android Studio package, open a terminal window, change directory to the location where Android Studio is to be installed, and execute the following command:

			tar xvfz /<path to package>/android-studio-<version>-linux.tar.gz

			Note that the Android Studio bundle will be installed into a subdirectory named android-studio. Therefore, assuming that the above command was executed in /home/demo, the software packages will be unpacked into /home/demo/android-studio.

			To launch Android Studio, open a terminal window, change directory to the android-studio/bin sub-directory, and execute the following command:

			./studio.sh

			2.4 Installing additional Android SDK packages

			When you launch Android Studio, the Welcome to Android Studio screen will appear as shown below:

			[image: ]

			Figure 2-2

			The steps performed so far have installed the Android Studio IDE and the current set of default Android SDK packages. Before proceeding, it is worth taking some time to verify which packages are installed and to install any missing or updated packages. 

			This task can be performed by clicking on the More Actions link within the welcome dialog and selecting the SDK Manager option from the drop-down menu. Once invoked, the Android SDK screen of the Settings dialog will appear as shown in Figure 2-3:

			[image: ]

			Figure 2-3

			Google pairs each release of Android Studio with a maximum supported Application Programming Interface (API) level of the Android SDK. In the case of Android Studio Jellyfish, this is Android UpsideDownCake (API Level 34).  This information can be confirmed using the following link:

			https://developer.android.com/studio/releases#api-level-support

			Immediately after installing Android Studio for the first time, it is likely that only the latest supported version of the Android SDK has been installed. To install older versions of the Android SDK, select the checkboxes corresponding to the versions and click the Apply button. The rest of this book assumes that the Android UpsideDownCake (API Level 34) SDK is installed.

			Most of the examples in this book will support older versions of Android as far back as Android 8.0 (Oreo). This ensures that the apps run on a wide range of Android devices. Within the list of SDK versions, enable the checkbox next to Android 8.0 (Oreo) and click the Apply button. Click the OK button to install the SDK in the resulting confirmation dialog. Subsequent dialogs will seek the acceptance of licenses and terms before performing the installation. Click Finish once the installation is complete.

			It is also possible that updates will be listed as being available for the latest SDK. To access detailed information about the packages that are ready to be updated, enable the Show Package Details option located in the lower right-hand corner of the screen. This will display information similar to that shown in Figure 2-4:
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			Figure 2-4

			The above figure highlights the availability of an update. To install the updates, enable the checkbox to the left of the item name and click the Apply button.

			In addition to the Android SDK packages, several tools are also installed for building Android applications. To view the currently installed packages and check for updates, remain within the SDK settings screen and select the SDK Tools tab as shown in Figure 2-5:
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			Figure 2-5

			Within the Android SDK Tools screen, make sure that the following packages are listed as Installed in the Status column:

			•Android SDK Build-tools

			•Android Emulator

			•Android SDK Platform-tools

			•Google Play Services

			•Intel x86 Emulator Accelerator (HAXM installer)*

			•Google USB Driver (Windows only)

			•Layout Inspector image server for API 31-34

			*Note that the Intel x86 Emulator Accelerator (HAXM installer) cannot be installed on Apple silicon-based Macs.

			If any of the above packages are listed as Not Installed or requiring an update, select the checkboxes next to those packages and click the Apply button to initiate the installation process. If the HAXM emulator settings dialog appears, select the recommended memory allocation:
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			Figure 2-6

			Once the installation is complete, review the package list and ensure that the selected packages are listed as Installed in the Status column. If any are listed as Not installed, make sure they are selected and click the Apply button again.

			2.5 Installing the Android SDK Command-line Tools

			Android Studio includes tools that allow some tasks to be performed from your operating system command line. To install these tools on your system, open the SDK Manager, select the SDK Tools tab, and locate the Android SDK Command-line Tools (latest) package as shown in Figure 2-7:

			[image: ] 

			Figure 2-7

			If the command-line tools package is not already installed, enable it and click Apply, followed by OK to complete the installation. When the installation completes, click Finish and close the SDK Manager dialog.

			For the operating system on which you are developing to be able to find these tools, it will be necessary to add them to the system’s PATH environment variable. 

			Regardless of your operating system, you will need to configure the PATH environment variable to include the following paths (where <path_to_android_sdk_installation> represents the file system location into which you installed the Android SDK):

			<path_to_android_sdk_installation>/sdk/cmdline-tools/latest/bin

			<path_to_android_sdk_installation>/sdk/platform-tools

			You can identify the location of the SDK on your system by launching the SDK Manager and referring to the Android SDK Location: field located at the top of the settings panel, as highlighted in Figure 2-8:
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			Figure 2-8

			Once the location of the SDK has been identified, the steps to add this to the PATH variable are operating system dependent:

			2.5.1 Windows 8.1

			1. On the start screen, move the mouse to the bottom right-hand corner of the screen and select Search from the resulting menu. In the search box, enter Control Panel. When the Control Panel icon appears in the results area, click on it to launch the tool on the desktop.

			2. Within the Control Panel, use the Category menu to change the display to Large Icons. From the list of icons, select the one labeled System.

			3. In the Environment Variables dialog, locate the Path variable in the System variables list, select it, and click  the Edit… button. Using the New button in the edit dialog, add two new entries to the path. For example, assuming the Android SDK was installed into C:\Users\demo\AppData\Local\Android\Sdk, the following entries would need to be added:

			C:\Users\demo\AppData\Local\Android\Sdk\cmdline-tools\latest\bin

			C:\Users\demo\AppData\Local\Android\Sdk\platform-tools

			4. Click OK in each dialog box and close the system properties control panel.

			Open a command prompt window by pressing Windows + R on the keyboard and entering cmd into the Run dialog. Within the Command Prompt window, enter:

			echo %Path%

			The returned path variable value should include the paths to the Android SDK platform tools folders. Verify that the platform-tools value is correct by attempting to run the adb tool as follows:

			adb

			The tool should output a list of command-line options when executed. 

			Similarly, check the tools path setting by attempting to run the AVD Manager command-line tool (don’t worry if the avdmanager tool reports a problem with Java - this will be addressed later):

			avdmanager

			If a message similar to the following message appears for one or both of the commands, it is most likely that an incorrect path was appended to the Path environment variable:

			'adb' is not recognized as an internal or external command,

			operable program or batch file.

			2.5.2 Windows 10

			Right-click on the Start menu, select Settings from the resulting menu and enter “Edit the system environment variables” into the Find a setting text field. In the System Properties dialog, click the Environment Variables... button. Follow the steps outlined for Windows 8.1 starting from step 3.

			2.5.3 Windows 11

			Right-click on the Start icon located in the taskbar and select Settings from the resulting menu. When the Settings dialog appears, scroll down the list of categories and select the “About” option. In the About screen, select Advanced system settings from the Related links section. When the System Properties window appears, click the Environment Variables... button. Follow the steps outlined for Windows 8.1 starting from step 3.

			2.5.4 Linux

			This configuration can be achieved on Linux by adding a command to the .bashrc file in your home directory (specifics may differ depending on the particular Linux distribution in use). Assuming that the Android SDK bundle package was installed into /home/demo/Android/sdk, the export line in the .bashrc file would read as follows:

			export PATH=/home/demo/Android/sdk/platform-tools:/home/demo/Android/sdk/cmdline-tools/latest/bin:/home/demo/android-studio/bin:$PATH

			Note also that the above command adds the android-studio/bin directory to the PATH variable. This will enable the studio.sh script to be executed regardless of the current directory within a terminal window.

			2.5.5 macOS

			Several techniques may be employed to modify the $PATH environment variable on macOS. Arguably the cleanest method is to add a new file in the /etc/paths.d directory containing the paths to be added to $PATH. Assuming an Android SDK installation location of /Users/demo/Library/Android/sdk, the path may be configured by creating a new file named android-sdk in the /etc/paths.d directory containing the following lines:

			/Users/demo/Library/Android/sdk/cmdline-tools/latest/bin

			/Users/demo/Library/Android/sdk/platform-tools

			Note that since this is a system directory, it will be necessary to use the sudo command when creating the file. For example:

			sudo vi /etc/paths.d/android-sdk

			2.6 Android Studio memory management

			Android Studio is a large and complex software application with many background processes. Although Android Studio has been criticized in the past for providing less than optimal performance, Google has made significant performance improvements in recent releases and continues to do so with each new version. These improvements include allowing the user to configure the amount of memory used by both the Android Studio IDE and the background processes used to build and run apps. This allows the software to take advantage of systems with larger amounts of RAM. 

			If you are running Android Studio on a system with sufficient unused RAM to increase these values (this feature is only available on 64-bit systems with 5GB or more of RAM) and find that Android Studio performance appears to be degraded, it may be worth experimenting with these memory settings. Android Studio may also notify you that performance can be increased via a dialog similar to the one shown below:
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			Figure 2-9

			To view and modify the current memory configuration, select the File -> Settings... main menu option (Android Studio -> Settings... on macOS) and, in the resulting dialog, select Appearance & Behavior followed by the  Memory Settings option listed under System Settings in the left-hand navigation panel, as illustrated in Figure 2-10 below:

			[image: ]

			Figure 2-10

			When changing the memory allocation, be sure not to allocate more memory than necessary or than your system can spare without slowing down other processes. 

			The IDE heap size setting adjusts the memory allocated to Android Studio and applies regardless of the currently loaded project. On the other hand, when a project is built and run from within Android Studio, several background processes (referred to as daemons) perform the task of compiling and running the app. When compiling and running large and complex projects, build time could be improved by adjusting the
daemon heap settings. Unlike the IDE heap settings, these daemon settings apply only to the current project and can only be accessed when a project is open in Android Studio. To display the SDK Manager from within an open project, select the Tools -> SDK Manager... menu option from the main menu.

			2.7 Updating Android Studio and the SDK

			From time to time, new versions of Android Studio and the Android SDK are released. New versions of the SDK are installed using the Android SDK Manager. Android Studio will typically notify you when an update is ready to be installed. 

			To manually check for Android Studio updates, use the Help -> Check for Updates... menu option from the Android Studio main window (Android Studio -> Check for Updates... on macOS).

			2.8 Summary

			Before beginning the development of Android-based applications, the first step is to set up a suitable development environment. This consists of the Android SDKs and Android Studio IDE (which also includes the OpenJDK development environment). This chapter covers the steps necessary to install these packages on Windows, macOS, and Linux.

		

	
		
			3. Creating an Example Android App in Android Studio

			The preceding chapters of this book have explained how to configure an environment suitable for developing Android applications using the Android Studio IDE. Before moving on to slightly more advanced topics, now is a good time to validate that all required development packages are installed and functioning correctly. The best way to achieve this goal is to create an Android application and compile and run it. This chapter will cover creating an Android application project using Android Studio. Once the project has been created, a later chapter will explore using the Android emulator environment to perform a test run of the application. 

			3.1 About the Project

			The project created in this chapter takes the form of a rudimentary currency conversion calculator (so simple, in fact, that it only converts from dollars to euros and does so using an estimated conversion rate). The project will also use one of the most basic Android Studio project templates. This simplicity allows us to introduce some  key aspects of Android app development without overwhelming the beginner by introducing too many concepts, such as the recommended app architecture and Android architecture components, at once. When following the tutorial in this chapter, rest assured that the techniques and code used in this initial example project will be covered in much greater detail later. 

			3.2 Creating a New Android Project

			The first step in the application development process is to create a new project within the Android Studio environment. Begin, therefore, by launching Android Studio so that the “Welcome to Android Studio” screen appears as illustrated in Figure 3-1:
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			Figure 3-1

			Once this window appears, Android Studio is ready for a new project to be created. To create the new project, click on the New Project option to display the first screen of the New Project wizard.

			3.3 Creating an Activity

			The next step is to define the type of initial activity to be created for the application. Options are available to create projects for Phone and Tablet, Wear OS, Television, or Automotive. A range of different activity types is available when developing Android applications, many of which will be covered extensively in later chapters. For this example, however, select the Phone and Tablet option from the Templates panel, followed by the option to create an Empty Views Activity. The Empty Views Activity option creates a template user interface consisting of a single TextView object.
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			Figure 3-2

			With the Empty Views Activity option selected, click Next to continue with the project configuration.

			3.4 Defining the Project and SDK Settings

			In the project configuration window (Figure 3-3), set the Name field to AndroidSample. The application name is the name by which the application will be referenced and identified within Android Studio and is also the name that would be used if the completed application were to go on sale in the Google Play store.

			The Package name uniquely identifies the application within the Android application ecosystem. Although this can be set to any string that uniquely identifies your app, it is traditionally based on the reversed URL of your domain name followed by the application’s name. For example, if your domain is www.mycompany.com, and the application has been named AndroidSample, then the package name might be specified as follows:

			com.mycompany.androidsample

			If you do not have a domain name, you can enter any other string into the Company Domain field, or you may use example.com for testing, though this will need to be changed before an application can be published:

			com.example.androidsample

			The Save location setting will default to a location in the folder named AndroidStudioProjects located in your home directory and may be changed by clicking on the folder icon to the right of the text field containing the current path setting.

			Set the minimum SDK setting to API 26 (Oreo; Android 8.0). This minimum SDK will be used in most projects created in this book unless a necessary feature is only available in a more recent version. The objective here is to build an app using the latest Android SDK while retaining compatibility with devices running older versions of Android (in this case, as far back as Android 8.0). The text beneath the Minimum SDK setting will outline the percentage of Android devices currently in use on which the app will run. Click on the Help me choose button (highlighted in Figure 3-3) to see a full breakdown of the various Android versions still in use:
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			Figure 3-3

			Finally, change the Language menu to Kotlin and select Kotlin DSL (build.gradle.kts) as the build configuration language before clicking Finish to create the project.

			3.5 Modifying the Example Application

			Once the project has been created, the main window will appear containing our AndroidSample project, as illustrated in Figure 3-4 below:
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			Figure 3-4

			The newly created project and references to associated files are listed in the Project tool window on the left side of the main project window. The Project tool window has several modes in which information can be displayed. By default, this panel should be in Android mode. This setting is controlled by the menu at the top of the panel as highlighted in Figure 3-5. If the panel is not currently in Android mode, use the menu to switch mode:
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			Figure 3-5

			3.6 Modifying the User Interface 

			The user interface design for our activity is stored in a file named activity_main.xml which, in turn, is located under app -> res -> layout in the Project tool window file hierarchy. Once located in the Project tool window, double-click on the file to load it into the user interface Layout Editor tool, which will appear in the center panel of the Android Studio main window:
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			Figure 3-6

			In the toolbar across the top of the Layout Editor window is a menu (currently set to Pixel in the above figure) which is reflected in the visual representation of the device within the Layout Editor panel. A range of other device options are available by clicking on this menu.

			Use the System UI Mode button ([image: ]) to turn Night mode on and off for the device screen layout. To change the orientation of the device representation between landscape and portrait, use the drop-down menu showing the [image: ] icon. 

			As we can see in the device screen, the content layout already includes a label that displays a “Hello World!” message. Running down the left-hand side of the panel is a palette containing different categories of user interface components that may be used to construct a user interface, such as buttons, labels, and text fields. However, it should be noted that not all user interface components are visible to the user. One such category consists of layouts. Android supports a variety of layouts that provide different levels of control over how visual user interface components are positioned and managed on the screen. Though it is difficult to tell from looking at the visual representation of the user interface, the current design has been created using a ConstraintLayout. This can be confirmed by reviewing the information in the Component Tree panel, which, by default, is located in the lower left-hand corner of the Layout Editor panel and is shown in Figure 3-7:
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			Figure 3-7

			As we can see from the component tree hierarchy, the user interface layout consists of a ConstraintLayout parent called main and a TextView child object. 

			Before proceeding, check that the Layout Editor’s Autoconnect mode is enabled. This means that as components are added to the layout, the Layout Editor will automatically add constraints to ensure the components are correctly positioned for different screen sizes and device orientations (a topic that will be covered in much greater detail in future chapters). The Autoconnect button appears in the Layout Editor toolbar and is represented by a U-shaped icon. When disabled, the icon appears with a diagonal line through it (Figure 3-8). If necessary, re-enable Autoconnect mode by clicking on this button.
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			Figure 3-8

			The next step in modifying the application is to add some additional components to the layout, the first of which will be a Button for the user to press to initiate the currency conversion. 

			The Palette panel consists of two columns, with the left-hand column containing a list of view component categories. The right-hand column lists the components contained within the currently selected category. In Figure 3-9, for example, the Button view is currently selected within the Buttons category:
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			Figure 3-9

			Click and drag the Button object from the Buttons list and drop it in the horizontal center of the user interface design so that it is positioned beneath the existing TextView widget:
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			Figure 3-10

			The next step is to change the text currently displayed by the Button component. The panel located to the right of the design area is the Attributes panel. This panel displays the attributes assigned to the currently selected component in the layout. Within this panel, locate the text property in the Common Attributes section and change the current value from “Button” to “Convert”, as shown in Figure 3-11:
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			Figure 3-11

			The second text property with a wrench next to it allows a text property to be set, which only appears within the Layout Editor tool but is not shown at runtime. This is useful for testing how a visual component and the layout will behave with different settings without running the app repeatedly.

			Just in case the Autoconnect system failed to set all of the layout connections, click on the Infer Constraints button (Figure 3-12) to add any missing constraints to the layout: 
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			Figure 3-12

			It is important to explain the warning button in the top right-hand corner of the Layout Editor tool, as indicated in Figure 3-13. This warning indicates potential problems with the layout. For details on any problems, click on the button:
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			Figure 3-13

			When clicked, the Problems tool window (Figure 3-14) will appear, describing the nature of the problems:
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			Figure 3-14

			This tool window is divided into two panels. The left panel (marked A in the above figure) lists issues detected within the layout file. In our example, only the following problem is listed:

			button <Button>: Hardcoded text

			When an item is selected from the list (B), the right-hand panel will update to provide additional detail on the problem (C). In this case, the explanation reads as follows:

			Hardcoded string "Convert", should use @string resource

			The tool window also includes a preview editor (D), allowing manual corrections to be made to the layout file. 

			This I18N message informs us that a potential issue exists concerning the future internationalization of the project (“I18N” comes from the fact that the word “internationalization” begins with an “I”, ends with an “N” and has 18 letters in between). The warning reminds us that attributes and values such as text strings should be stored as resources wherever possible when developing Android applications. Doing so enables changes to the appearance of the application to be made by modifying resource files instead of changing the application source code. This can be especially valuable when translating a user interface to a different spoken language. If all of the text in a user interface is contained in a single resource file, for example, that file can be given to a translator, who will then perform the translation work and return the translated file for inclusion in the application. This enables multiple languages to be targeted without the necessity for any source code changes to be made. In this instance, we are going to create a new resource named convert_string and assign to it the string “Convert”. 

			Begin by clicking on the Show Quick Fixes button (E) and selecting the Extract string resource option from the menu, as shown in Figure 3-15:
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			Figure 3-15

			After selecting this option, the Extract Resource panel (Figure 3-16) will appear. Within this panel, change the resource name field to convert_string and leave the resource value set to Convert before clicking on the OK button:
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			Figure 3-16

			The next widget to be added is an EditText widget, into which the user will enter the dollar amount to be converted. From the Palette panel, select the Text category and click and drag a Number (Decimal) component onto the layout so that it is centered horizontally and positioned above the existing TextView widget. With the widget selected, use the Attributes tools window to set the hint property to “dollars”. Click on the warning icon and extract the string to a resource named dollars_hint.

			The code written later in this chapter will need to access the dollar value entered by the user into the EditText field. It will do this by referencing the id assigned to the widget in the user interface layout. The default id assigned to the widget by Android Studio can be viewed and changed from within the Attributes tool window when the widget is selected in the layout, as shown in Figure 3-17:
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			Figure 3-17

			Change the id to dollarText and, in the Rename dialog, click on the Refactor button. This ensures that any references elsewhere within the project to the old id are automatically updated to use the new id:
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			Figure 3-18

			Repeat the steps to set the id of the TextView widget to textView, if necessary.

			Add any missing layout constraints by clicking on the Infer Constraints button. At this point, the layout should resemble that shown in Figure 3-19:
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			Figure 3-19

			3.7 Reviewing the Layout and Resource Files

			Before moving on to the next step, we will look at some internal aspects of user interface design and resource handling. In the previous section, we changed the user interface by modifying the activity_main.xml file using the Layout Editor tool. In fact, all that the Layout Editor was doing was providing a user-friendly way to edit the underlying XML content of the file. In practice, there is no reason why you cannot modify the XML directly to make user interface changes, and, in some instances, this may actually be quicker than using the Layout Editor tool. In the top right-hand corner of the Layout Editor panel are the View Modes buttons marked A through C in Figure 3-20 below:
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			Figure 3-20

			By default, the editor will be in Design mode (button C), whereby only the visual representation of the layout is displayed. In Code mode (A), the editor will display the XML for the layout, while in Split mode (B), both the layout and XML are displayed, as shown in Figure 3-21:
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			Figure 3-21

			The button to the left of the View Modes button (marked B in Figure 3-20 above) is used to toggle between Code and Split modes quickly.

			As can be seen from the structure of the XML file, the user interface consists of the ConstraintLayout component, which in turn, is the parent of the TextView, Button, and EditText objects. We can also see, for example, that the text property of the Button is set to our convert_string resource. Although complexity and content vary, all user interface layouts are structured in this hierarchical, XML-based way. 

			As changes are made to the XML layout, these will be reflected in the layout canvas. The layout may also be modified visually from within the layout canvas panel, with the changes appearing in the XML listing. To see this in action, switch to Split mode and modify the XML layout to change the background color of the ConstraintLayout to a shade of red as follows:

			<?xml version="1.0" encoding="utf-8"?>

			<androidx.constraintlayout.widget.ConstraintLayout xmlns:android="http://schemas.android.com/apk/res/android"

			    xmlns:app="http://schemas.android.com/apk/res-auto"

			    xmlns:tools="http://schemas.android.com/tools"

			    android:id="@+id/main"

			    android:layout_width="match_parent"

			    android:layout_height="match_parent"

			    tools:context=".MainActivity"

			    android:background="#ff2438" >

			.

			.

			</androidx.constraintlayout.widget.ConstraintLayout>

			Note that the layout color changes in real-time to match the new setting in the XML file. Note also that a small red square appears in the XML editor’s left margin (also called the gutter) next to the line containing the color setting. This is a visual cue to the fact that the color red has been set on a property. Clicking on the red square will display a color chooser allowing a different color to be selected:
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			Figure 3-22

			Before proceeding, delete the background property from the layout file so that the background returns to the default setting.

			Finally, use the Project panel to locate the app -> res -> values -> strings.xml file and double-click on it to load it into the editor. Currently, the XML should read as follows:

			<resources>

			    <string name="app_name">AndroidSample</string>

			    <string name="convert_string">Convert</string>

			    <string name="dollars_hint">dollars</string>

			</resources>

			To demonstrate resources in action, change the string value currently assigned to the convert_string resource to “Convert to Euros” and then return to the Layout Editor tool by selecting the tab for the layout file in the editor panel. Note that the layout has picked up the new resource value for the string. 

			There is also a quick way to access the value of a resource referenced in an XML file. With the Layout Editor tool in Split or Code mode, click on the “@string/convert_string” property setting so that it highlights, and then press Ctrl-B on the keyboard (Cmd-B on macOS). Android Studio will subsequently open the strings.xml file and take you to the line in that file where this resource is declared. Use this opportunity to revert the string resource to the original “Convert” text and to add the following additional entry for a string resource that will be referenced later in the app code:

			<resources>

			    <string name="app_name">AndroidSample</string>

			    <string name="convert_string">Convert</string>

			    <string name="dollars_hint">dollars</string>

			    <string name="no_value_string">No Value</string>

			</resources>

			Resource strings may also be edited using the Android Studio Translations Editor by clicking on the Open editor link in the top right-hand corner of the editor window. This will display the Translation Editor in the main panel of the Android Studio window:
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			Figure 3-23

			This editor allows the strings assigned to resource keys to be edited and for translations for multiple languages to be managed.

			3.8 Adding Interaction

			The final step in this example project is to make the app interactive so that when the user enters a dollar value into the EditText field and clicks the convert button, the converted euro value appears on the TextView. This involves the implementation of some event handling on the Button widget. Specifically, the Button needs to be configured so that a method in the app code is called when an onClick event is triggered. Event handling can be implemented in several ways and is covered in a later chapter entitled “An Overview and Example of Android Event Handling”. Return the layout editor to Design mode, select the Button widget in the layout editor, refer to the Attributes tool window, and specify a method named convertCurrency as shown below:
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			Figure 3-24

			Next, double-click on the MainActivity.kt file in the Project tool window (app -> kotlin+java -> <package name> -> MainActivity) to load it into the code editor and add the code for the convertCurrency method to the class file so that it reads as follows, noting that it is also necessary to import some additional Android packages:

			package com.example.androidsample

			 

			import android.os.Bundle

			import androidx.activity.enableEdgeToEdge

			import androidx.appcompat.app.AppCompatActivity

			import androidx.core.view.ViewCompat

			import androidx.core.view.WindowInsetsCompat

			import android.view.View

			import android.widget.EditText

			import android.widget.TextView

			 

			class MainActivity : AppCompatActivity() {

			    override fun onCreate(savedInstanceState: Bundle?) {

			        super.onCreate(savedInstanceState)

			.

			.

			        }

			    }

			 

			    fun convertCurrency(view: View) { 

			        val dollarText: EditText = findViewById(R.id.dollarText)

			        val textView: TextView = findViewById(R.id.textView)

			 

			        if (dollarText.text.isNotEmpty()) {

			            val dollarValue = dollarText.text.toString().toFloat()

			            val euroValue = dollarValue * 0.85f

			            textView.text = euroValue.toString()

			        } else {

			            textView.text = getString(R.string.no_value_string)

			        }

			    }

			}

			The method begins by obtaining references to the EditText and TextView objects by making a call to a method named findViewById, passing through the id assigned within the layout file. A check is then made to ensure that the user has entered a dollar value, and if so, that value is extracted, converted from a String to a floating point value, and converted to euros. Finally, the result is displayed on the TextView widget. 

			If any of this is unclear, rest assured that these concepts will be covered in greater detail in later chapters. In particular, the topic of accessing widgets from within code using findByViewId and an introduction to an alternative technique referred to as view binding will be covered in the chapter entitled “An Overview of Android View Binding”.

			3.9 Summary

			While not excessively complex, several steps are involved in setting up an Android development environment. Having performed those steps, it is worth working through an example to ensure the environment is correctly installed and configured. In this chapter, we have created an example application and then used the Android Studio Layout Editor tool to modify the user interface layout. In doing so, we explored the importance of using resources wherever possible, particularly string values, and briefly touched on layouts. Next, we looked at the underlying XML used to store Android application user interface designs. 

			Finally, an onClick event was added to a Button connected to a method implemented to extract the user input from the EditText component, convert it from dollars to euros and then display the result on the TextView.

			With the app ready for testing, the steps necessary to set up an emulator for testing purposes will be covered in detail in the next chapter.

		

	


		
			4. Creating an Android Virtual Device (AVD) in Android Studio

			Although the Android Studio Preview panel allows us to see the layout we are designing, compiling and running an entire app will be necessary to thoroughly test that it works. An Android application may be tested by installing and running it on a physical device or in an Android Virtual Device (AVD) emulator environment. Before an AVD can be used, it must first be created and configured to match the specifications of a particular device model. In this chapter, we will work through creating such a virtual device using the Pixel 4 phone as a reference example.

			4.1 About Android Virtual Devices

			AVDs are emulators that allow Android applications to be tested without needing to install the application on a physical Android-based device. An AVD may be configured to emulate various hardware features, including screen size, memory capacity, and the presence or otherwise of features such as a camera, GPS navigation support, or an accelerometer. Several emulator templates are installed as part of the standard Android Studio installation, allowing AVDs to be configured for various devices. Custom configurations may be created to match any physical Android device by specifying properties such as processor type, memory capacity, and the size and pixel density of the screen. 

			An AVD session can appear as a separate window or embedded within the Android Studio window. 

			New AVDs are created and managed using the Android Virtual Device Manager, which may be used in command-line mode or with a more user-friendly graphical user interface. To create a new AVD, the first step is to launch the AVD Manager. This can be achieved from within the Android Studio environment by clicking the Device Manager button in the right-hand tool window bar, as indicated in Figure 4-1:
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			Figure 4-1

			Once opened, the manager will appear as a tool window, as shown in Figure 4-2:
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			Figure 4-2

			If you installed Android Studio for the first time on a computer (as opposed to upgrading an existing Android Studio installation), the installer might have created an initial AVD instance ready for use, as shown in Figure 4-3:
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			Figure 4-3

			If this AVD is present on your system, you can use it to test apps. If no AVD was created, or you would like to create AVDs for different device types, follow the steps in the rest of this chapter. 

			To add a new AVD, click on the ‘+’ button in the Device Manager toolbar and select the Create Virtual Device option to open the Virtual Device Configuration dialog:
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			Figure 4-4

			Within the dialog, perform the following steps to create a Pixel 4-compatible emulator:

			1. Select the Phone option From the Category panel to display the available Android phone AVD templates.

			2. Select the Pixel 4 device option and click Next.

			3. On the System Image screen, select the latest version of Android. If the system image has not yet been installed, a Download link will be provided next to the Release Name. Click this link to download and install the system image before selecting it. If the image you need is not listed, click on the x86 Images (or ARM images if you are running a Mac with Apple Silicon) and Other images tabs to view alternative lists.

			4. Click Next to proceed and enter a descriptive name (for example, Pixel 4 API 34) into the name field or accept the default name.

			5. Click Finish to create the AVD.

			6. If future modifications to the AVD are necessary, re-open the Device Manager, select the AVD from the list, and click on the pencil icon in the Actions column to edit the settings.

			4.2 Starting the Emulator

			To test the newly created AVD emulator, select the emulator from the Device Manager and click the triangle shaped Start button. The emulator will appear embedded into the main Android Studio window and begin the startup process. The amount of time it takes for the emulator to start will depend on the configuration of both the AVD and the system on which it is running:
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			Figure 4-5

			To hide and show the emulator tool window, click the Running Devices tool window button (marked A above). Click the “x” close button next to the tab (B) to exit the emulator. The emulator tool window can accommodate multiple emulator sessions, with each session represented by a tab. Figure 4-6, for example, shows a tool window with two emulator sessions:

			[image: ]

			Figure 4-6

			To switch between sessions, click on the corresponding tab. 

			Although the emulator probably defaulted to appearing in portrait orientation, this and other default options can be changed. Within the Device Manager, select the new Pixel 4 entry and click on the pencil icon in the Actions column of the device row. In the configuration screen, locate the Startup orientation section and change the orientation setting. Exit and restart the emulator session to see this change take effect. More details on the emulator are covered in the next chapter, “Using and Configuring the Android Studio AVD Emulator”).

			To save time in the next section of this chapter, leave the emulator running before proceeding.

			4.3 Running the Application in the AVD

			With an AVD emulator configured, the example AndroidSample application created in the earlier chapter can now be compiled and run. With the AndroidSample project loaded into Android Studio, make sure that the newly created Pixel 4 AVD is displayed in the device menu (marked A in Figure 4-7 below), then either click the run button represented by a triangle (B), select the Run -> Run ‘app’ menu option, or use the Ctrl-R keyboard shortcut:
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			Figure 4-7

			The device menu (A) may be used to select a different AVD instance or physical device as the run target and also to run the app on multiple devices. The menu also provides access to the Device Manager as well as device connection configuration and troubleshooting options:
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			Figure 4-8

			Once the application is installed and running, the user interface for the first fragment will appear within the emulator (a fragment is a reusable section of an Android project typically consisting of a user interface layout and some code, a topic which will be covered later in the chapter entitled “An Introduction to Android Fragments”):
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			Figure 4-9

			Once the run process begins, the Run tool window will appear. The Run tool window will display diagnostic information as the application package is installed and launched. Figure 4-10 shows the Run tool window output from a typical successful application launch:
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			Figure 4-10

			If problems are encountered during the launch process, the Run tool window will provide information to help isolate the problem’s cause.

			Assuming the application loads into the emulator and runs as expected, we have safely verified that the Android development environment is correctly installed and configured. With the app running, try performing a currency conversion to verify that the app works as intended.

			4.4 Running on Multiple Devices

			The run target menu shown in Figure 4-8 above includes an option to run the app on multiple emulators and devices in parallel. When selected, this option displays the dialog in Figure 4-11, providing a list of the AVDs configured on the system and any attached physical devices. Enable the checkboxes next to the emulators or devices to be targeted before clicking on the Run button:
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			Figure 4-11

			After clicking the Run button, Android Studio will launch the app on the selected emulators and devices.

			4.5 Stopping a Running Application

			To stop a running application, click the stop button located in the main toolbar, as shown in Figure 4-12:
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			Figure 4-12

			An app may also be terminated using the Run tool window. Begin by displaying the Run tool window using the window bar button that becomes available when the app is running. Once the Run tool window appears, click the stop button highlighted in Figure 4-13 below:
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			Figure 4-13

			4.6 Supporting Dark Theme

			To test how an app behaves when dark theme is enabled, open the Settings app within the running Android instance in the emulator, choose the Display category, and enable the Dark theme option as shown in Figure 4-14:
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			Figure 4-14

			With dark theme enabled, run the AndroidSample app and note that it appears using a dark theme, including a black background and a purple background color on the button, as shown in Figure 4-15:
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			Figure 4-15

			Return to the Settings app and turn off Dark theme mode before continuing.

			4.7 Running the Emulator in a Separate Window

			So far in this chapter, we have only used the emulator as a tool window embedded within the main Android Studio window. The emulator can be configured to appear in a separate window within the Settings dialog, which can be displayed by clicking on the IDE and Project Settings button located in the Android Studio toolbar, as highlighted in Figure 4-16:
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			Figure 4-16

			Within the Settings dialog, navigate to Tools -> Emulator in the side panel, and disable the Launch in the Running Devices tool window option:
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			Figure 4-17

			With the option disabled, click the Apply button followed by OK to commit the change, then exit the current emulator session by clicking on the close button on the tab marked B in Figure 4-5 above.

			Run the sample app once again, at which point the emulator will appear as a separate window, as shown below:
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			Figure 4-18

			The choice of standalone or tool window mode is a matter of personal preference. If you prefer the emulator running in a tool window, return to the settings screen and re-enable the Launch in the Running Devices tool window option. Before committing to standalone mode, however, keep in mind that the Running Devices tool window may also be detached from the main Android Studio window from within the tool window Options menu, which is accessed by clicking the button indicated in Figure 4-19:
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			Figure 4-19

			From within the Options menu, select View Mode -> Float to detach the tool window from the Android Studio main window:
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			Figure 4-20

			To re-dock the Running Devices tool window, click on the Dock button shown in Figure 4-21:
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			Figure 4-21

			4.8 Removing the Device Frame

			The emulator can be configured to appear with or without the device frame. To change the setting, exit the emulator, open the Device Manager, select the AVD from the list, and click on the menu button indicated by the arrow in Figure 4-22:
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			Figure 4-22

			Select the Edit option and, in the settings screen, locate and switch off the Enable device frame option before clicking the Finish button:
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			Figure 4-23

			Once the device frame has been disabled, the emulator will appear as shown in Figure 4-24 the next time it is launched:
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			Figure 4-24

			4.9 Summary

			A typical application development process follows a coding, compiling, and running cycle in a test environment. Android applications may be tested on a physical Android device or an Android Virtual Device (AVD) emulator. AVDs are created and managed using the Android Studio Device Manager tool, which may be used as a command-line tool or via a graphical user interface. When creating an AVD to simulate a specific Android device model, the virtual device should be configured with a hardware specification matching that of the physical device.

			The AVD emulator session may be displayed as a standalone window or embedded into the main Android Studio user interface.

		

	


		
			5. Using and Configuring the Android Studio AVD Emulator 

			Before the next chapter explores testing on physical Android devices, this chapter will take some time to provide an overview of the Android Studio AVD emulator and highlight many of the configuration features available to customize the environment in both standalone and tool window modes.

			5.1 The Emulator Environment

			When launched in standalone mode, the emulator displays an initial splash screen during the loading process. Once loaded, the main emulator window appears, containing a representation of the chosen device type (in the case of Figure 5-1, this is a Pixel 4 device):
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			Figure 5-1

			The toolbar positioned along the right-hand edge of the window provides quick access to the emulator controls and configuration options.

			5.2 Emulator Toolbar Options

			The emulator toolbar (Figure 5-2) provides access to a range of options relating to the appearance and behavior of the emulator environment.
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			Figure 5-2

			Each button in the toolbar has associated with it a keyboard accelerator which can be identified either by hovering the mouse pointer over the button and waiting for the tooltip to appear or via the help option of the extended controls panel.

			Though many of the options contained within the toolbar are self-explanatory, each option will be covered for the sake of completeness:

			•Exit / Minimize – The uppermost ‘x’ button in the toolbar exits the emulator session when selected, while the ‘-’ option minimizes the entire window.

			•Power – The Power button simulates the hardware power button on a physical Android device. Clicking and releasing this button will lock the device and turn off the screen. Clicking and holding this button will initiate the device “Power off” request sequence.

			•Volume Up / Down – Two buttons that control the audio volume of playback within the simulator environment.

			•Rotate Left/Right – Rotates the emulated device between portrait and landscape orientations.

			•Take Screenshot – Takes a screenshot of the content displayed on the device screen. The captured image is stored at the location specified in the Settings screen of the extended controls panel, as outlined later in this chapter.

			•Zoom Mode – This button toggles in and out of zoom mode, details of which will be covered later in this chapter.

			•Back – Performs the standard Android “Back” navigation to return to a previous screen.

			•Home – Displays the device’s home screen. 

			•Overview – Simulates selection of the standard Android “Overview” navigation, which displays the currently running apps on the device.

			•Fold Device – Simulates the folding and unfolding of a foldable device. This option is only available if the emulator is running a foldable device system image. 

			•Extended Controls – Displays the extended controls panel, allowing for the configuration of options such as simulated location and telephony activity, battery strength, cellular network type, and fingerprint identification.

			5.3 Working in Zoom Mode

			The zoom button located in the emulator toolbar switches in and out of zoom mode. When zoom mode is active, the toolbar button is depressed, and the mouse pointer appears as a magnifying glass when hovering over the device screen. Clicking the left mouse button will cause the display to zoom in relative to the selected point on the screen, with repeated clicking increasing the zoom level. Conversely, clicking the right mouse button decreases the zoom level. Toggling the zoom button off reverts the display to the default size.

			Clicking and dragging while in zoom mode will define a rectangular area into which the view will zoom when the mouse button is released.

			While in zoom mode, the screen’s visible area may be panned using the horizontal and vertical scrollbars located within the emulator window.

			5.4 Resizing the Emulator Window

			The emulator window’s size (and the device’s corresponding representation) can be changed at any time by enabling Zoom mode and clicking and dragging on any of the corners or sides of the window.

			5.5 Extended Control Options

			The extended controls toolbar button displays the panel illustrated in Figure 5-3. By default, the location settings will be displayed. Selecting a different category from the left-hand panel will display the corresponding group of controls:
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			Figure 5-3

			5.5.1 Location

			The location controls allow simulated location information to be sent to the emulator as decimal or sexigesimal coordinates. Location information can take the form of a single location or a sequence of points representing the device’s movement, the latter being provided via a file in either GPS Exchange (GPX) or Keyhole Markup Language (KML) format. Alternatively, the integrated Google Maps panel may be used to select single points or travel routes visually.

			5.5.2 Displays

			In addition to the main display shown within the emulator screen, the Displays option allows additional displays to be added running within the same Android instance. This can be useful for testing apps for dual-screen devices such as the Microsoft Surface Duo. These additional screens can be configured to be any required size and appear within the same emulator window as the main screen.

			5.5.3 Cellular

			The type of cellular connection being simulated can be changed within the cellular settings screen. Options are available to simulate different network types (CSM, EDGE, HSDPA, etc.) in addition to a range of voice and data scenarios, such as roaming and denied access.

			5.5.4 Battery

			Various battery state and charging conditions can be simulated on this panel of the extended controls screen, including battery charge level, battery health, and whether the AC charger is currently connected.

			5.5.5 Camera

			The emulator simulates a 3D scene when the camera is active. This takes the form of the interior of a virtual building through which you can navigate by holding down the Option key (Alt on Windows) while using the mouse pointer and keyboard keys when recording video or before taking a photo within the emulator. This extended configuration option allows different images to be uploaded for display within the virtual environment.

			5.5.6 Phone

			The phone extended controls provide two straightforward but helpful simulations within the emulator. The first option simulates an incoming call from a designated phone number. This can be particularly useful when testing how an app handles high-level interrupts.

			The second option allows the receipt of text messages to be simulated within the emulator session. As in the real world, these messages appear within the Message app and trigger the standard notifications within the emulator.

			5.5.7 Directional Pad

			A directional pad (D-Pad) is an additional set of controls either built into an Android device or connected externally (such as a game controller) that provides directional controls (left, right, up, down). The directional pad settings allow D-Pad interaction to be simulated within the emulator.

			5.5.8 Microphone

			The microphone settings allow the microphone to be enabled and virtual headset and microphone connections to be simulated. A button is also provided to launch the Voice Assistant on the emulator.

			5.5.9 Fingerprint

			Many Android devices are now supplied with built-in fingerprint detection hardware. The AVD emulator makes it possible to test fingerprint authentication without the need to test apps on a physical device containing a fingerprint sensor. Details on configuring fingerprint testing within the emulator will be covered later in this chapter.

			5.5.10 Virtual Sensors

			The virtual sensors option allows the accelerometer and magnetometer to be simulated to emulate the effects of the physical motion of a device, such as rotation, movement, and tilting through yaw, pitch, and roll settings.

			5.5.11 Snapshots

			Snapshots contain the state of the currently running AVD session to be saved and rapidly restored, making it easy to return the emulator to an exact state. Snapshots are covered later in this chapter.

			5.5.12 Record and Playback

			Allows the emulator screen and audio to be recorded and saved in WebM or animated GIF format.

			5.5.13 Google Play

			If the emulator is running a version of Android with Google Play Services installed, this option displays the current Google Play version. It also provides the option to update the emulator to the latest version.

			5.5.14 Settings

			The settings panel provides a small group of configuration options. Use this panel to choose a darker theme for the toolbar and extended controls panel, specify a file system location into which screenshots are to be saved, configure OpenGL support levels, and configure the emulator window to appear on top of other windows on the desktop.

			5.5.15 Help

			The Help screen contains three sub-panels containing a list of keyboard shortcuts, links to access the emulator online documentation, file bugs and send feedback, and emulator version information.

			5.6 Working with Snapshots

			When an emulator starts for the first time, it performs a cold boot, much like a physical Android device when powered on. This cold boot process can take some time to complete as the operating system loads and all the background processes are started. To avoid the necessity of going through this process every time the emulator is started, the system is configured to automatically save a snapshot (referred to as a quick-boot snapshot) of the emulator’s current state each time it exits. The next time the emulator is launched, the quick-boot snapshot is loaded into memory, and execution resumes from where it left off previously, allowing the emulator to restart in a fraction of the time needed for a cold boot to complete.

			The Snapshots screen of the extended controls panel can store additional snapshots at any point during the execution of the emulator. This saves the exact state of the entire emulator allowing the emulator to be restored to the exact point in time that the snapshot was taken. From within the screen, snapshots can be taken using the Take Snapshot button (marked A in Figure 5-4). To restore an existing snapshot, select it from the list (B) and click the run button (C) located at the bottom of the screen. Options are also provided to edit (D) the snapshot name and description and to delete (E) the currently selected snapshot:
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			Figure 5-4

			You can also choose whether to start an emulator using either a cold boot, the most recent quick-boot snapshot, or a previous snapshot by making a selection from the run target menu in the main toolbar, as illustrated in Figure 5-5:
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			Figure 5-5

			5.7 Configuring Fingerprint Emulation

			The emulator allows up to 10 simulated fingerprints to be configured and used to test fingerprint authentication within Android apps. Configuring simulated fingerprints begins by launching the emulator, opening the Settings app, and selecting the Security option.

			Within the Security settings screen, select the fingerprint option. On the resulting information screen, click on the Next button to proceed to the Fingerprint setup screen. Before fingerprint security can be enabled, a backup screen unlocking method (such as a PIN) must be configured. Enter and confirm a suitable PIN and complete the PIN entry process by accepting the default notifications option.

			Proceed through the remaining screens until the Settings app requests a fingerprint on the sensor. At this point, display the extended controls dialog, select the Fingerprint category in the left-hand panel, and make sure that Finger 1 is selected in the main settings panel:
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			Figure 5-6

			Click on the Touch Sensor button to simulate Finger 1 touching the fingerprint sensor. The emulator will report the successful addition of the fingerprint:
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			Figure 5-7

			To add additional fingerprints, click on the Add Another button and select another finger from the extended controls panel menu before clicking on the Touch Sensor button again. 

			5.8 The Emulator in Tool Window Mode

			As outlined in the previous chapter (“Creating an Android Virtual Device (AVD) in Android Studio”), Android Studio can be configured to launch the emulator in an embedded tool window so that it does not appear in a separate window. When running in this mode, the same controls available in standalone mode are provided in the toolbar, as shown in Figure 5-8:
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			Figure 5-8

			From left to right, these buttons perform the following tasks (details of which match those for standalone mode):

			•Power

			•Volume Up

			•Volume Down

			•Rotate Left

			•Rotate Right

			•Back

			•Home 

			•Overview

			•Screenshot

			•Snapshots

			•Extended Controls

			5.9 Creating a Resizable Emulator

			In addition to emulators configured to match specific Android device models, Android Studio also provides a resizable AVD that allows you to switch between phone, tablet, and foldable device sizes. To create a resizable emulator, open the Device Manager and click the ‘+’ toolbar button. Next, select the Resizable device definition illustrated in Figure 5-9, and follow the usual steps to create a new AVD:
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			Figure 5-9

			When you run an app on the new emulator within a tool window, the Display mode option will appear in the toolbar, allowing you to switch between emulator configurations as shown in Figure 5-10:
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			Figure 5-10

			If the emulator is running in standalone mode, the Display mode option can be found in the side toolbar, as shown below:
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			Figure 5-11

			Once a foldable display mode has been selected, the Change posture menu may be used to test the app in open, closed, and half-open configurations:
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			Figure 5-12

			5.10 Summary

			Android Studio contains an Android Virtual Device emulator environment designed to make it easier to test applications without running them on a physical Android device. This chapter has provided a brief tour of the emulator and highlighted key features available to configure and customize the environment to simulate different testing conditions.

		

	
		
			6. A Tour of the Android Studio User Interface

			While it is tempting to plunge into running the example application created in the previous chapter, it involves using aspects of the Android Studio user interface, which are best described in advance. 

			Android Studio is a powerful and feature-rich development environment that is, to a large extent, intuitive to use. That being said, taking the time now to gain familiarity with the layout and organization of the Android Studio user interface will shorten the learning curve in later chapters of the book. With this in mind, this chapter will provide an overview of the various areas and components of the Android Studio environment.

			6.1 The Welcome Screen

			The welcome screen (Figure 6-1) is displayed any time that Android Studio is running with no projects currently open (open projects can be closed at any time by selecting the File -> Close Project menu option). If Android Studio was previously exited while a project was still open, the tool will bypass the welcome screen the next time it is launched, automatically opening the previously active project.
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			Figure 6-1

			In addition to a list of recent projects, the welcome screen provides options for performing tasks such as opening and creating projects, along with access to projects currently under version control. In addition, the Customize screen provides options to change the theme and font settings used by both the IDE and the editor. Android Studio plugins may be viewed, installed, and managed using the Plugins option.

			Additional options are available by selecting the More Actions link or using the menu shown in Figure 6-2 when the list of recent projects replaces the More Actions link:
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			Figure 6-2

			6.2 The Menu Bar

			The Android Studio main window will appear when a new project is created, or an existing one is opened. When multiple projects are open simultaneously, each will be assigned its own main window. The precise configuration of the window will vary depending on the operating system Android Studio is running on and which tools and panels were displayed the last time the project was open. The appearance, for example, of the main menu bar will differ depending on the host operating system. On macOS, Android Studio follows the standard convention of placing the menu bar along the top edge of the desktop, as illustrated in Figure 6-3:
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			Figure 6-3

			When Android Studio is running on Windows or Linux, however, the main menu is accessed via the button highlighted in Figure 6-4:
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			Figure 6-4

			6.3 The Main Window

			Once a project is open, the Android Studio main window will typically resemble that of Figure 6-5:
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			Figure 6-5

			The various elements of the main window can be summarized as follows:

			A – Toolbar – A selection of shortcuts to frequently performed actions. The toolbar buttons provide quick access to a select group of menu bar actions. The toolbar can be customized by right-clicking on the bar and selecting the Customize Toolbar… menu option. The toolbar menu shown in Figure 6-6 provides a convenient way to perform tasks such as creating and opening projects and switching between windows when multiple projects are open:
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			Figure 6-6

			B – Navigation Bar – The navigation bar provides a convenient way to move around the files and folders that make up the project. Clicking on an element in the navigation bar will drop down a menu listing the sub-folders and files at that location, ready for selection. Similarly, clicking on a class name displays a menu listing methods contained within that class:
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			Figure 6-7

			Select a method from the list to be taken to the corresponding location within the code editor. You can hide, display, and change the position of this bar using the View -> Appearance -> Navigation Bar menu option.

			C – Editor Window – The editor window displays the content of the file on which the developer is currently working. When multiple files are open, each file is represented by a tab located along the top edge of the editor, as shown in Figure 6-8:
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			Figure 6-8

			D – Status Bar – The status bar displays informational messages about the project and the activities of Android Studio. Hovering over items in the status bar will display a description of that field. Many fields are interactive, allowing users to click to perform tasks or obtain more detailed status information.
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			Figure 6-9

			The widgets displayed in the status bar can be changed using the View -> Appearance -> Status Bar Widgets menu.

			E – Project Tool Window – The project tool window provides a hierarchical overview of the project file structure allowing navigation to specific files and folders to be performed. The toolbar can be used to display the project in several different ways. The default setting is the Android view which is the mode primarily used in the remainder of this book.

			The project tool window is just one of many available tools within the Android Studio environment. 

			6.4 The Tool Windows

			In addition to the project view tool window, Android Studio also includes many other windows, which, when enabled, are displayed tool window bars that appear along the left and right edges of the main window and contain buttons for showing and hiding each of the tool windows. Figure 6-10 shows typical tool window bar configurations, though the buttons and their positioning may differ for your Android Studio installation.
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			Figure 6-10

			Clicking on a button will display the corresponding tool window, while a second click will hide the window. The location of a button in a tool window bar indicates the side of the window against which the window will appear when displayed. These positions can be changed by clicking and dragging the buttons to different locations in other window toolbars.

			Android Studio offers a wide range of tool windows, the most commonly used of which are as follows:

			•Project (A) – The project view provides an overview of the file structure that makes up the project allowing for quick navigation between files. Generally, double-clicking on a file in the project view will cause that file to be loaded into the appropriate editing tool.

			•Resource Manager (B) - A tool for adding and managing resources and assets within the project, such as images, colors, and layout files.

			•More Tool Windows (C) - Displays a menu containing additional tool windows not currently displayed in a tool window bar. When a tool window is selected from this menu, it will appear as a button in a tool window bar.

			•Build (D) - Displays a real-time view of each process step while Android Studio builds the current project.

			•Run (E)  – The run tool window becomes available when an application is currently running and provides a view of the results of the run together with options to stop or restart a running process. If an application fails to install and run on a device or emulator, this window typically provides diagnostic information about the problem.

			•App Quality Insights (F) - Provides access to the cloud-based Firebase app quality and crash analytics platform.

			•Logcat (G) – The Logcat tool window provides access to the monitoring log output from a running application and options for taking screenshots and videos of the application and stopping and restarting a process.

			•Problems (H) - A central location to view all of the current errors or warnings within the project. Double-clicking on an item in the problem list will take you to the problem file and location.

			•Terminal (I) – Provides access to a terminal window on the system on which Android Studio is running. On Windows systems, this is the Command Prompt interface, while on Linux and macOS systems, this takes the form of a Terminal prompt.

			•Version Control (J) - This tool window is used when the project files are under source code version control, allowing access to Git repositories and code change history.

			•Notifications (K) - This tool window is used when the project files are under source code version control, allowing access to Git repositories and code change history.

			•Gradle (L) – The Gradle tool window provides a view of the Gradle tasks that make up the project build configuration. The window lists the tasks involved in compiling the various elements of the project into an executable application. Right-click on a top-level Gradle task and select the Open Gradle Config menu option to load the Gradle build file for the current project into the editor. Gradle will be covered in greater detail later in this book.

			•Device Manager (M) - Provides access to the Device Manager tool window where physical Android device connections and emulators may be added, removed, and managed. 

			•Running Devices (N) - Contains the AVD emulator if the option has been enabled to run the emulator in a tool window as outlined in the chapter entitled “Creating an Android Virtual Device (AVD) in Android Studio”.

			•Gemini (O) - Android Studio’s AI powered coding assistant. Currently in preview, this tool helps you develop your app by providing coding suggestions and solutions.

			•Assistant (P) - Display the Assistant panel, the content of which will differ depending on which Android Studio feature you are currently using.

			•App Inspection - Provides access to the Database and Background Task inspectors. The Database Inspector allows you to inspect, query, and modify your app’s databases while running. The Background Task Inspector allows background worker tasks created using WorkManager to be monitored and managed.

			•Bookmarks – The Bookmarks tool window provides quick access to bookmarked files and code lines. For example, right-clicking on a file in the project view allows access to an Add to Bookmarks menu option. Similarly, you can bookmark a line of code in a source file by moving the cursor to that line and pressing the F11 key (F3 on macOS). All bookmarked items can be accessed through this tool window.

			•Build Variants – The build variants tool window provides a quick way to configure different build targets for the current application project (for example, different builds for debugging and release versions of the application or multiple builds to target different device categories).

			•Device File Explorer – Available via the View -> Tool Windows -> Device File Explorer menu, this tool window provides direct access to the filesystem of the currently connected Android device or emulator, allowing the filesystem to be browsed and files copied to the local filesystem.

			•Layout Inspector - Provides a visual 3D rendering of the hierarchy of components that make up a user interface layout.

			•Structure – The structure tool provides a high-level view of the structure of the source file currently displayed in the editor. This information includes a list of items such as classes, methods, and variables in the file. Selecting an item from the structure list will take you to that location in the source file in the editor window.

			•TODO – As the name suggests, this tool provides a place to review items that have yet to be completed on the project. Android Studio compiles this list by scanning the source files that make up the project to look for comments that match specified TODO patterns. These patterns can be reviewed and changed by opening the Settings dialog and navigating to the TODO entry listed under Editor.

			6.5 The Tool Window Menus

			Each tool window has its own toolbar along the top edge. The menu buttons within these toolbars vary from one tool to the next, though all tool windows contain an Options menu (marked A in Figure 6-11):
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			Figure 6-11

			The Options menu allows various aspects of the window to be changed. Figure 6-12, for example, shows the Options menu for the Project tool window. Settings are available, for example, to undock a window and to allow it to float outside of the boundaries of the Android Studio main window, and to move and resize the tool panel: 
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			Figure 6-12

			All tool windows also include a far-right button on the toolbar (marked B in Figure 6-11 above), providing an additional way to hide the tool window from view. A search of the items within a tool window can be performed by giving that window focus by clicking on it and then typing the search term (for example, the name of a file in the Project tool window). A search box will appear in the window’s toolbar, and items matching the search highlighted.

			6.6 Android Studio Keyboard Shortcuts

			Android Studio includes many keyboard shortcuts to save time when performing common tasks. A complete keyboard shortcut keymap listing can be viewed and printed from within the Android Studio project window by selecting the Help -> Keyboard Shortcuts PDF menu option. You may also list and modify the keyboard shortcuts by opening the Settings dialog and clicking on the Keymap entry, as shown in Figure 6-13 below:
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			Figure 6-13

			6.7 Switcher and Recent Files Navigation

			Another useful mechanism for navigating within the Android Studio main window involves using the Switcher. Accessed via the Ctrl-Tab keyboard shortcut, the switcher appears as a panel listing both the tool windows and currently open files (Figure 6-14). 

			[image: ]

			Figure 6-14

			Once displayed, the switcher will remain visible as long as the Ctrl key remains depressed. Repeatedly tapping the Tab key while holding down the Ctrl key will cycle through the various selection options while releasing the Ctrl key causes the currently highlighted item to be selected and displayed within the main window.

			In addition to the Switcher, the Recent Files panel provides navigation to recently opened files (Figure 6-15). This can be accessed using the Ctrl-E keyboard shortcut (Cmd-E on macOS). Once displayed, either the mouse pointer can be used to select an option, or the keyboard arrow keys can be used to scroll through the file name and tool window options. Pressing the Enter key will select the currently highlighted item:
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			Figure 6-15

			6.8 Changing the Android Studio Theme

			The overall theme of the Android Studio environment may be changed using the Settings dialog. Once the settings dialog is displayed, select the Appearance & Behavior option in the left-hand panel, followed by Appearance. Then, change the setting of the Theme menu before clicking on the OK button. The themes available will depend on the platform but usually include options such as Light, IntelliJ, Windows, High Contrast, and Darcula. Figure 6-16 shows an example of the main window with the Dark theme selected:
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			Figure 6-16

			To synchronize the Android Studio theme with the operating system light and dark mode setting, enable the Sync with OS option and use the drop-down menu to control which theme to use for each mode:
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			Figure 6-17

			Hundreds of additional themes are available for download in the Android Studio Marketplace, which can be accessed by clicking on the Get more themes link.

			6.9 Summary

			The primary elements of the Android Studio environment consist of the welcome screen and main window. Each open project is assigned its own main window, which, in turn, consists of a menu bar, toolbar, editing and design area, status bar, and a collection of tool windows. Tool windows appear on the sides of the main window.

			There are very few actions within Android Studio that cannot be triggered via a keyboard shortcut. A keymap of default keyboard shortcuts can be accessed at any time from within the Android Studio main window.

		

	
		
			7. Testing Android Studio Apps on a Physical Android Device

			While much can be achieved by testing applications using an Android Virtual Device (AVD), there is no substitute for performing real-world application testing on a physical Android device, and some Android features are only available on physical Android devices. 

			Communication with both AVD instances and connected Android devices is handled by the Android Debug Bridge (ADB). This chapter explains how to configure the adb environment to enable application testing on an Android device with macOS, Windows, and Linux-based systems.

			7.1 An Overview of the Android Debug Bridge (ADB)

			The primary purpose of the ADB is to facilitate interaction between a development system, in this case, Android Studio, and both AVD emulators and Android devices to run and debug applications. ADB allows you to connect to devices via WiFi or USB cable.

			The ADB consists of a client, a server process running in the background on the development system, and a daemon background process running in either AVDs or real Android devices such as phones and tablets. 

			The ADB client can take a variety of forms. For example, a client is provided as a command-line tool named adb  in the Android SDK platform-tools sub-directory. Similarly, Android Studio also has a built-in client.

			A variety of tasks may be performed using the adb command-line tool. For example, active virtual or physical devices may be listed using the devices command-line argument. The following command output indicates the presence of an AVD on the system but no physical devices:

			$ adb devices

			List of devices attached

			emulator-5554   device

			7.2 Enabling USB Debugging ADB on Android Devices

			Before ADB can connect to an Android device, that device must be configured to allow the connection. On phone and tablet devices running Android 6.0 or later, the steps to achieve this are as follows:

			1. Open the Settings app on the device and select the About tablet or About phone option (on some versions of Android, this can be found on the System page of the Settings app).

			2. On the About screen, scroll down to the Build number field (Figure 7-1) and tap it seven times until a message indicates that developer mode has been enabled. If the Build number is not listed on the About screen, it may be available via the Software information option. Alternatively, unfold the Advanced section of the list if available.
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			Figure 7-1

			3. Return to the main Settings screen and note the appearance of a new option titled Developer options (on newer versions of Android, this option is listed on the System settings screen). Select this option, and on the resulting screen, locate the USB debugging option as illustrated in Figure 7-2:
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			Figure 7-2

			4. Enable the USB debugging option and tap the Allow button when confirmation is requested. 

			If you use a Samsung Galaxy device, you may need to turn off the Auto Blocker feature in the Settings app before enabling the debugging option.

			The device is now configured to accept debugging connections from adb on the development system over a USB connection. All that remains is to configure the development system to detect the device when it is attached. While this is a relatively straightforward process, the steps differ depending on whether the development system runs Windows, macOS, or Linux. Note that the following steps assume that the Android SDK platform-tools directory is included in the operating system PATH environment variable as described in the chapter entitled “Setting up an Android Studio Development Environment”.

			7.2.1 macOS ADB Configuration

			To configure the ADB environment on a macOS system, connect the device to the computer system using a USB cable, open a terminal window, and execute the following command to restart the adb server:

			$ adb kill-server

			$ adb start-server

			* daemon not running. starting it now on port 5037 *

			* daemon started successfully *

			Once the server is successfully running, execute the following command to verify that the device has been detected:

			$ adb devices

			List of devices attached

			74CE000600000001        offline

			If the device is listed as offline, go to the Android device and check for the dialog shown in Figure 7-3 seeking permission to Allow USB debugging. Enable the checkbox next to the option that reads Always allow from this computer before clicking OK. 
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			Figure 7-3

			Repeating the adb devices command should now list the device as being available:

			List of devices attached

			015d41d4454bf80c        device

			If the device is not listed, try logging out and back into the macOS desktop and rebooting the system if the problem persists.

			7.2.2 Windows ADB Configuration

			The first step in configuring a Windows-based development system to connect to an Android device using ADB is to install the appropriate USB drivers on the system. The USB drivers to install will depend on the model of the Android Device. If you have a Google device such as a Pixel phone, installing and configuring the Google USB Driver package on your Windows system will be necessary. Detailed steps to achieve this are outlined on the following web page:

			https://developer.android.com/sdk/win-usb.html
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